
Goldeneye Setup Editor V2.0 Importing New 
Sounds/Midis Tutorial
By SubDrag

Importing new sounds and midis are exciting new capabilities for both Perfect Dark and 
GoldenEye.  For sounds, GoldenEye imports wave files while Perfect Dark imports 
mp3s, but using audio tools formats are easily switched.  It uses midis for midi import. 
There is more information in each section (4 sections).  

Precursors:
GoldenEye Setup Editor 2.4 or later
Audacity 1.3.10 beta or later (http://audacity.sourceforge.net/download/)
Sound to import (wav or mp3 capable)
LAME encoder (http://www.rarewares.org/mp3-lame-bundle.php, 
http://www.rarewares.org/dancer/dancer.php?f=226 is an example, LAME 3.98.2 
command line). 

Sounds  - GoldenEye

We'll start by finding a sound we want to use in a level.  Here is a fun one (if this site's 
still up when you read this), from the movie GoldenEye:
http://www.angelfire.com/tx3/GoldenEye69/images/BETTER.wav

Now we'll open Audacity:

http://audacity.sourceforge.net/download/
http://www.rarewares.org/dancer/dancer.php?f=226
http://www.rarewares.org/mp3-lame-bundle.php
http://www.angelfire.com/tx3/GoldenEye69/images/BETTER.wav


Open up the sound, in this case BETTER.wav

First thing we need to do is change the Project Rate (Hz) in the bottom left.  Change this 
to 22050, which is what GoldenEye uses.



Now change the audio to mono.  If the sound was stereo, you will need to split and delete 
half (click the X) next to it once it's split up (see PD section for info how to).  To change 
to mono, click the downward triangle next to  BETTER on left side, and pick Mono.



Now File → Export, and choose signed 16-bit PCM and save the wave (overwrite is ok). 
Use default options (don't fill any in on next page).



Now go to GoldenEye Setup Editor.

Tools → 21990

Choose the last tab. This is where sounds are imported/changed.



There are two combo boxes, the Sfx Bank Instrument is the sound bank, while Instrument 
Bank Instruments modifies instruments.  Although instrument sounds can be edited, 
mostly sound effects are added/changed.

There are two things that can be done: Importing over current sounds or adding new 
sounds to the end of the bank.

To replace a sound, choose in the Sound combo box (after picking 0000 in Sfx Bank 
Instruments). Then click Import 16-bit Raw.  Lets do sound C1, which is runway shutter 
door opening.  Click import 16-bit raw,  choose BETTER.wav.  If all goes well the Raw 
checkbox will turn to checked.

Now lets add a sound to the end of the bank for use in action blocks.  Still in sound 
editor, click Add 16-Bit Raw Wav to End.  Pick BETTER.wav.

After picking the sound, it should switch to 0105, and show Raw.  You can click Play 
Sound to double check results or play one of originals.



Leave the 21990 Editor open.  Now it's time to make a sample setup file to use this 
sound.

NOTE: This next part is an example, in reality you will edit your levels as you see fit, not 
repeating this process, but similar method.

Do File → New, and pick Runway. Hit OK.

Open up Visual Editor, Edit Setup → Visual Editor.

Insert a preset then set as solo start point.

Now Edit Setup → Action Blocks.  Add block 1000 so it's executed all the time.



Make an action block similar to the below (to play sound every so often, repeating 
forever).  

IMPORTANT: Sounds shown here are +1 of what they were in sound editor (beause 
0000 is no sound).  Therefore we had 0105 before, now pick 0106.  Any new sounds says 
CUSTOM DIGIT ONLY.



Save file to UsetuprunZ.bin. File → Save Uncompressed.

Go back to 21990 Editor. Go to Stage Options tab.



Now under Files, pick the UsetuprunZ (file 0276) combo, then inject by clicking Inject 
File and Upd Tables, picking this File.

Click Delete Debug Data (and J Text) to make room.

Now click Write ROM with 21990 Mods, and save it to new ROM (Goldeneye.rom.rom). 
Open ROM in PJ64.

You may want to turn down music so can hear sound better.



We didn't add any shutter doors, but you should hear the wav repeating over and over 
again! If you add a shutter door to a level (left to reader) and open it, you will trigger 
sound effect.  Note there are many parameters on sound tab which can help you make it 
sound better.  Also, you may want to tone down or off music since Rare never really had 
sound effects.  

You can easily now add sound effects, and use action blocks to play them on demand! 
Also feel free to replace instruments, sounds, gunshots, etc.

Sounds - Perfect Dark

Perfect Dark uses actual mp3 for its sound effects (instruments use adpcm, and does not 
currently support raw, so there is no way at present to import new instruments, similar to 
how GE is done).  These mp3s (for import) must eventually be 22050 hz, Mono, and 24 
kbps, with original bit flag set to 0 (copy of original).  Unfortunately Audacity at present 
cannot export with original bit flag to 0, so that is only an optional intermediate step. 
We'll use LAME to actually encode it with correct parameters.  



First install lame.exe into the main editor folder (default C:\program files\geedit2\). It is 
not included with the editor for legal reasons.  

Next find a sound we want to use in a level.  Mp3s work great, but waves as bases are 
preferable so that there is no additional loss going from mp3 back to mp3.  I'm going to 
pick a random song my hard drive called Kalimba.mp3.  Note we can't play the whole 
song, as PD's ROM cannot be expanded infinitely at the moment, so just note we'll chop 
it off.  

Now we'll open Audacity for that:

Drag the file into Audacity or open it up. This one is rather large, but you can certainly 
open up wavs, smaller mp3s, etc.



First thing to do is since it's stereo, split to mono, then delete half.  So click the 
downward triangle near the Kalimba 1 name, and pick Split Stereo to Mono.

Now it should look split up.  



Click the X to left of either half in order to make it mono.

Change the project sampling rate to 22050 in the bottom left.



Now we need to shrink mp3, so select the right mostpart on sound waveform (leave 15 
secs or so).

Now hit Delete on keyboard.



Time to export.  File->Export. Choose WAV and save (similar to how was done for GE). 
It will turn into an mp3 when injected into Perfect Dark, but the GoldenEye Setup Editor 
will handle this using LAME encoder.

Open up the GoldenEye Setup Editor.  It most likely will be in GoldenEye mode.



We need to switch to PD.  Choose Tools → Switch Editor Game (GE/PD)

You should now be in Perfect Dark mode.



 If you haven't set your PD quick ROM, you will need to do Tools → Preferences, then 
pick a clean Perfect Dark ROM.





Now hit OK, and Tools → 39850

A dialog will come up. 

Click Delete Debug Data (and J Text) and Clean Unused Files to make room for mp3.

Go to File section. Here are a list of all PD files.  Any starting with A are audio files 
(mp3s) and can be injected over.

We'll pick 0447, Ap16_01_joM.  This is the beginning sound from Joanna in Air Base. 
The status bar says what text it is.  Full list is at bottom of this document.



Now click Inject audio file (converted to PD Mp3), and pick this wav file we saved.

The filesizes should update:

Now click Write ROM with 39850 Mods, save ROM.

Open up in PJ64 (change emulator settings for PD) and listen to the new sound.  In 
future, also should be able to change action blocks, etc, for more fun.  Maybe even add 
extras.

Midis – GoldenEye

Open up the GoldenEye Setup Editor and Tools → 21990.  Switch to model details tab.

Choose the midi you want to edit in the Music Entry.  We'll do Dam here.



If you want the midi to play once, leave the Loop Midi Import unchecked.  You most 
likely want it to loop, so click the Loop Midi Import check.

Click replace Midi with .mid.

Pick a midi of your choosing, then click OK.  Most midis are compatible, but must have a 
max of 16 tracks, does not support percussion, and note that the size should not be 
extraordinary.

Click Delete Debug Data (and J Text).  
Click Write ROM with 21990 Mods and your level will now have the new midi.



Midis – Perfect Dark

First switch into PD mode, by Tools → Switch Editor Game (see Perfect Dark sound 
section for more details).

Now Tools → 39850.  Dialog opens.  Click Model Details tab.

Pick desired level to replace, here will pick Extraction.

If you want the midi to play once, leave the Loop Midi Import unchecked.  You most 
likely want it to loop, so click the Loop Midi Import check.

Click replace Midi with .mid.
NOTE: Perfect Dark does not support midis larger than original size yet, unlike 
GoldenEye.



Pick a midi of your choosing, then click OK.  Most midis are compatible, but must have a 
max of 16 tracks, does not support percussion, and note that the size should not be 
extraordinary.

Go to Stage Options Tab.  Click Delete Debug Data (and J Text).   Click Clean Unused 
Files.

Now click Write ROM with 39850 Mods and your level will now have the Midi in it.

List of known PD audio files:

0x0272 = "OK you know the way from here."; // Arecep02M
0x0273 = "Please holster your weapon miss."; // Arecep03M
0x0274 = "Weapons are not allowed in the base."; // Arecep04M
0x0276 = "Right I'm calling security."; // Arecep06M
0x027F = "Should you be in here?"; // Ascie2bM
0x0280 = "Please don't hurt me."; // Ascie2cM
0x0286 = "Leave this area now."; // Ascie3bM



0x0289 = "You vandal you've broken it!"; // Ascie3eM
0x028E = "I'll shut it down."; // Ascien4_aM
0x029A = "Oh no! We have a problem. It's a single seater!"; // Aa51elv01M
0x029B = "Two can get in but no more."; // Aa51elv02M
0x029C = "Plus it's got no style you know what I'm saying?"; // Aa51elv03M
0x02A5 = "Imposter!"; // Aa51grd09M
0x02A6 = "It's a spy!"; // Aa51grd10M
0x02A7 = "It's the only way out of here."; // Aa51jo1M
0x02A8 = "You're the only one who can fly it Elvis so get in."; // Aa51jo2M
0x02A9 = "But we can't leave you behind."; // Aa51jo3M
0x02AA = "There must be a way out of here."; // Aa51jo4M
0x02AB = "I don't have much time!!!"; // Aa51jo5M
0x02AC = "Jonathan go with Elvis. I'll see to the consoles."; // Aa51jo6M
0x02B3 = "Joanna - over here."; // Aa51jon07M
0x02B4 = "We need to get back to our friend."; // Aa51jon08M
0x02B5 = "Right we're near. Cover me Jo..."; // Aa51jon09M
0x02B6 = "Okay - stand back."; // Aa51jon10M
0x02B7 = "Okay Jo - let's go."; // Aa51jon11M
0x02B9 = "One of us will have to stay behind and open the *hangar doors."; // Aa51jon14M
0x02BA = "I'll get out on that hoverbike. Cover me while I *open the doors."; // Aa51jon15M
0x02BB = "Hey that's not..."; // Aa51sci1M
0x02BC = "Mr. President you're in danger. Trent is trying to *kidnap you."; // Aaf1jo01M
0x02BD = "This is a recording of a meeting between*Trent and the other conspirators."; // 

Aaf1jo02M
0x02BE = "We must get to the escape pod. Follow me."; // Aaf1jo03M
0x02C4 = "Security SECURITY!!"; // Aaf1pr06M
0x02C5 = "Who are you young lady?"; // Aaf1pr07M
0x02C6 = "You can't make accusations like that without evidence.* I assume that you have 

some?"; // Aaf1pr08M
0x02C7 = "Seems overwhelming... I'm in your hands.*What do we do now?"; // Aaf1pr09M
0x02CA = "You'll never save him now."; // Aaf1tr02M
0x02CB = "Ha Ha Ha Ha Ha."; // Aaf1tr03M
0x02DC = "Look out - it's an intruder..."; // Aairstw01M
0x02DD = "Is he OK?"; // Aairstw02M
0x02DE = "I'll go and get some help."; // Aairstw03M
0x02E1 = "Good to see you Joanna."; // Aassael03M
0x02E2 = "Take this - you should find it useful..."; // Aassael04M
0x02E3 = "Look out Joanna! I think we've made them angry..."; // Aassael05M
0x02E4 = "Time to head upwards. I'll take this lift *you take the other one."; // Aassael06M
0x02E5 = "Hey you - this is a restricted area."; // Absewrk01M
0x02E6 = "Are you new around here?"; // Absewrk02M
0x02E7 = "Hey - give me back my case."; // Absewrk03M
0x02E8 = "Upstairs...there's an intruder."; // Absewrk04M
0x02E9 = "You get security - I'll deal with her..."; // Absewrk05M
0x02EA = "Here take this gun and keep those Skedar *off my back while I'm working."; // 

Acetael01M
0x02ED = "Look out! She's got a gun."; // Acsec01M
0x02F4 = "Who are you and what are you doing here?"; // Adevr03M
0x02F5 = "You won't shoot me!"; // Adevr04M
0x02F6 = "Don't you know who I am?"; // Adevr05M
0x02F7 = "Let's see how you deal with security."; // Adevr06M
0x02FE = "Don't shoot don't shoot!"; // Aexec01M
0x02FF = "I'll do what you want..."; // Aexec02M
0x0300 = "HELP - Intruder!"; // Aexec04M
0x0301 = "Logging on now..."; // Aexec05M
0x0302 = "Okay I'm in..."; // Aexec06M



0x0303 = "Goodbye Dr. Caroll."; // Aexec07M
0x0304 = "I...I'm logging on now."; // Aexec08M
0x0305 = "Right I'm in..."; // Aexec09M
0x0322 = "I've got a password problem and you're *the man to help me with it."; // Ajoexec01M
0x0323 = "Move it!"; // Ajoexec02M
0x0325 = "Pull the plug on that now."; // Ajosci02M
0x0326 = "Switch this thing off."; // Ajosci03M
0x032D = "Who are you?"; // Alabtech1M
0x032E = "Hey - you've got my clothes."; // Alabtech2M
0x032F = "Help - help!"; // Alabtech3M
0x0331 = "There's an intruder in the complex."; // Alabtech6M
0x0332 = "Give me back my clothes - or else!"; // Alabtech7M
0x0333 = "Right - you've asked for it!"; // Alabtech8M
0x0334 = "Give me my clothes."; // Alabtech9M
0x0338 = "Stop them - they're breaking into the safe..."; // Aoffwrk04M
0x03A2 = "The other hub has got to be in the *Security Room."; // Am1_l1_cM
0x03A5 = "Something around here's using a lot of power."; // Am1_l2_bM
0x03AA = "I can't leave any bodyguards standing."; // Am1_l3_cM
0x03AC = "If I get the wind generator back online *I'll get power to the lower basement."; // 

Am2_l1_aM
0x03AD = "I've got to be quick or they'll kill *the negotiator!"; // Am2_l1_bM
0x03AE = "Here's where they must be holding Daniel."; // Am2_l1_cM
0x03AF = "Those hackers have to be stopped before *I rescue Daniel."; // Am2_l1_dM
0x03B1 = "Either of those blocked-up doors will *do as an escape route."; // Am3_l1_bM
0x03B4 = "There's no way through while those *lasers are active."; // Am3_l2_aM
0x03B5 = "That must be the meeting room up ahead. *Time to use the CamSpy."; // Am3_l2_bM
0x03B7 = "Time to leave! Let's get to the door I set *up earlier."; // Am3_l2_dM
0x03B9 = "There's the antenna but... I can't throw a bug *that high!"; // Am4_l1_bM
0x03BC = "The showers... Now if I can convince someone*to part with their uniform..."; // 

Am4_l2_aM
0x03BE = "The air's heavily recycled around here - must* be near the autopsy lab."; // 

Am4_l2_cM
0x03C0 = "The medpack's got to be somewhere around here."; // Am4_l3_aM
0x03C1 = "Time to hook up with Jonathan before he gets *into any more trouble."; // Am4_l3_bM
0x03C2 = "That smell... oil... I smelt that in the other *hangars."; // Am4_l3_cM
0x03C3 = "The jetbike should get me out before they lock *the base down."; // Am4_l3_dM
0x03C7 = "So that's Air Force One? ... Huh smaller*than I thought."; // Am5_l1_dM
0x03C8 = "Now let's retrieve the evidence."; // Am5_l2_aM
0x03CB = "Maybe a mine will detach the UFO."; // Am5_l2_dM
0x03CC = "There's the escape pod."; // Am5_l3_aM
0x03CD = "Maybe there's a beacon in there."; // Am5_l3_bM
0x03CE = "The jamming... It's coming from that ship."; // Am5_l3_cM
0x03CF = "Elvis... He'll be able to protect the President."; // Am5_l3_dM
0x03D1 = "This must be where the sub's controlled from."; // Am6_l1_bM
0x03D2 = "Without the autopilot and the GPS the ship *will wander off station."; // Am6_l1_cM
0x03D3 = "They'll be unable to conduct any operations *without any power."; // Am6_l1_dM
0x03D4 = "This will help us to get round the *ship quicker."; // Am6_l2_aM
0x03D5 = "This antibody masking will protect us from *the automatic defenses."; // Am6_l2_bM
0x03D6 = "There's Dr. Caroll. Let's see if we can *reverse what was done to him."; // Am6_l2_cM
0x03D7 = "We have to get out of here!"; // Am6_l2_dM
0x03D8 = "The autodefenses will really help me out."; // Am7_l1_aM
0x03D9 = "So this is what Foster was working on."; // Am7_l1_bM
0x03DA = "I'll have to go carefully... The hostages are *counting on me."; // Am7_l1_cM
0x03DB = "Well at least I won't know if I'm doing *anything wrong."; // Am7_l1_dM
0x03DC = "I've got to get those shields down to let Elvis *in. I need all the help I can get."; // 

Am8_l1_aM



0x03DD = "Now only the hangar bay doors are in the way."; // Am8_l1_bM
0x03DE = "This machine contains the Skedar star maps."; // Am8_l1_cM
0x03DF = "If we control the bridge then the ship is ours."; // Am8_l1_dM
0x03E0 = "This seems to be one of the special pillars."; // Am9_l1_aM
0x03E1 = "The power's more constant in this area. *The Inner Sanctum can't be far away."; // 

Am9_l1_bM
0x03E2 = "OH NO!!! A Skedar army in suspended animation!"; // Am9_l1_cM
0x03E3 = "Okay this is it... Cut off the head and the *body will perish."; // Am9_l1_dM
0x03E4 = "Why the big hurry?"; // Ap1_01_joM
0x03E5 = "If Dr. Caroll is not extracted tonight *dataDyne will put him through mind 

*conditioning and we'll lose our best *chance of finding out what dataDyne *are up to."; // Ap1_02_caM
0x03E6 = "Are they all expendable?"; // Ap1_03_joM
0x03E7 = "Don't joke! You have to be careful Joanna. *Code keys will only operate while the 

owner *is alive... If you kill them the key is *useless. Armed guards are a different matter *of course."; // 
Ap1_04_caM

0x03E8 = "What's the target location?"; // Ap1_05_joM
0x03E9 = "Work your way down the building to the ground *level. Dr. Caroll will be in a research 

lab *somewhere in the underground facility."; // Ap1_06_caM
0x03EA = "How will I recognize him?"; // Ap1_07_joM
0x03EB = "We don't have an image record and we can't *find any official files. All we have is the 

*name. Good luck Perfect Dark."; // Ap1_08_caM
0x03EC = "Dr. Caroll?"; // Ap2_01_joM
0x03ED = "Dr. Caroll are you here?"; // Ap2_02_joM
0x03EE = "Well is it safe to come out?"; // Ap2_03_drM
0x03EF = "Yes all clear."; // Ap2_04_joM
0x03F0 = "Wh..what... you're..."; // Ap2_05_joM
0x03F1 = "Very professionally done my dear but there's *no time to waste! We must leave 

immediately!"; // Ap2_06_drM
0x03F2 = "Come on. I have vital information and you *must protect me."; // Ap2_07_drM
0x03F3 = "Sound the alarm - she's here!"; // Ap3_01_gdM
0x03F4 = "Lights out!"; // Ap3_02_joM
0x03F5 = "What the...?"; // Ap3_03_joM
0x03F6 = "Going somewhere?"; // Ap4_01_dvM
0x03F7 = "Something I can do for you old woman?"; // Ap4_02_joM
0x03F8 = "Return our sapient immediately! You don't *know what you're doing."; // 

Ap4_03_dvM
0x03F9 = "Yes I do. I'm leaving."; // Ap4_04_joM
0x03FA = "One more chance! Give it back and you *could come and work for me."; // 

Ap4_05_dvM
0x03FB = "Sorry! Gotta shoot."; // Ap4_06_joM
0x03FC = "You must get the sapient back. We cannot *proceed without it."; // Ap4_07_blM
0x03FD = "I know that!"; // Ap4_08_dvM
0x03FE = "I also know who to talk to... *Mr. Carrington."; // Ap4_09_dvM
0x03FF = "Agent Dark Mission Log 1846 hours. Last *night we got a call from Cassandra de 

Vries. *A dataDyne team have taken Daniel Carrington *hostage at his private villa on the coast *and they 
say they will spare his life in *exchange for the AI."; // Ap5_01_joM

0x0400 = "Unfortunately we don't have it. Daniel and *Dr. Caroll were at the villa to discuss 
*'matters of mutual interest.' It looks *like Daniel found a way to hide Dr. Caroll *inside the villa when the 
dataDyne hit *squad arrived."; // Ap5_02_joM

0x0401 = "Hopefully our phoney negotiator ploy will *give me a chance to surprise the dataDyne 
*squad. This time it's not just my life *on the line."; // Ap5_03_joM

0x0402 = "Sir? Are you injured?"; // Ap6_01_joM
0x0403 = "No Joanna I'm okay but those dataDyne *thugs made me tell them where I'd hidden 

*Dr. Caroll. If only I'd held out for a *few minutes more..."; // Ap6_02_caM
0x0404 = "It's not your fault sir. I should have *been quicker."; // Ap6_03_joM



0x0405 = "Don't blame yourself Joanna. Dr. Caroll *told me that he expected this to happen. 
*Actually when they recaptured him the *dataDyne team got overconfident and let *slip a few facts when 
they thought I was *unconscious. They mentioned a meeting in *the G5 Building in Chicago Illinois 
*tonight. I want you to be there but that *doesn't leave you a lot of time to get *ready."; // Ap6_04_caM

0x0406 = "That won't be a problem sir. So did *Dr. Caroll have any useful information *for 
you?"; // Ap6_05_joM

0x0407 = "Oh yes indeed. He certainly did and *I'll brief you when you're en route to *Chicago. 
We might still be able to help *him even after those butchers remove his *personality. He thinks they'll 
keep a *copy of it in a safe place. It's about *time I called in some friends to deal *with dataDyne."; // 
Ap6_06_caM

0x0408 = "We suspect the G5 Corporation is just a *front for dataDyne and whoever else is 
*involved in this plot. I know Cassandra *de Vries is going to be here but I need *to know who else is 
attending and what *they discuss. By the time you get out *the help I requested should have arrived."; // 
Ap7_01_caM

0x0409 = "Just who is this help you keep *referring to?"; // Ap7_02_joM
0x040A = "Not now Joanna. Time for radio silence. *Good luck!"; // Ap7_03_caM
0x040B = "Thanks a lot."; // Ap7_04_joM
0x040C = "We've recovered the sapient from Carrington *and altered its programming. It no 

longer *has a personality so there will be no *further incidents."; // Ap8_01_dvM
0x040D = "This will reduce its efficiency. My team will *have to take it to the core themselves. 

This *will endanger them. You should have *anticipated that the sapient might develop *a troublesome 
moral code."; // Ap8_02_blM

0x040E = "No one could have predicted that! And I *resent being singled out for blame! *What 
about him?"; // Ap8_03_dvM

0x040F = "The President turned down your request for *the loan of the Pelagic II?"; // 
Ap8_04_blM

0x0410 = "Could it be you overestimated your *influence over him?"; // Ap8_06_blM
0x0411 = "No! Perhaps I underestimated his resolve. *We have a contingency plan ready to go 

*and we will move as soon as the Presidential *entourage arrives at the air base. All I *need from the 
President is a tissue sample."; // Ap8_07_trM

0x0412 = "Ha! Assuming you don't get any interference. *If Carrington has pieced together 
enough of *this he will have called for reinforcements."; // Ap8_08_dvM

0x0413 = "There will be no outside help for *Mr. Carrington. The technology you gave us *is 
installed in Nevada and fully operational. *We can intercept any craft they use."; // Ap8_09_trM

0x0414 = "Then the devices we gave you are working *correctly? Good. Because we believe 
*anything which does not work correctly *should be destroyed. Consider that as you *follow your backup 
plans.'"; // Ap8_10_blM

0x0415 = "Agent Dark reporting in! Prepare to *receive a download of the meeting data. *Priority 
request for an Institute Support *Team to protect the President before he *goes to Alaska."; // Ap9_01_joM

0x0416 = "No time for that now Agent Dark. There's *been a development during radio silence. 
*The craft carrying those friends' I was *talking about was shot down over Nevada. *The weapon 
responsible was fired from *Area 51... that's where the survivors and *debris will have been taken. You're 
to *prep for immediate dispatch when you *return here. Carrington out."; // Ap9_02_caM

0x0417 = "Area 51? But what about the President?"; // Ap9_03_joM
0x0418 = "Okay Joanna take a look at this. Our *operative inside Area 51 was able to get *this out 

to us."; // Ap10_01_caM
0x0419 = "This is your entry point... A deserted helipad *on the edge of the base."; // 

Ap10_02_caM
0x041A = "The lift down to the hangars and the *rendezvous point is beyond that wall... *Watch 

out for these guards."; // Ap10_03_caM
0x041B = "Here is the communications antenna. *Attach a comms rider bug so we can talk to 

*you when you're inside the base. Again *watch out for hostiles."; // Ap10_04_caM
0x041D = "Here is our friend. He appears to be *physically unhurt though he hasn't *regained 

consciousness yet. By the look *of it the surgeons are almost done with *their preliminary tests and will 
begin *dissection soon."; // Ap10_06_caM

0x041E = "But who was...?"; // Ap10_07_joM



0x041F = "Any questions? No. Good. Away you go to *the hangar."; // Ap10_08_caM
0x0420 = "Agent Dark Mission Log 1028 hours. Against *my better judgement I'm about to enter 

*Area 51."; // Ap10_09_joM
0x0421 = "Agent Dark! Over here!"; // Ap11_01_jnM
0x0422 = "There you are! I was beginning to wonder *if..."; // Ap11_02_joM
0x0423 = "If what?"; // Ap11_03_jnM
0x0424 = "If you'd been discovered yet. And frankly *if this is how you work I'm amazed that 

*you lasted longer than five minutes."; // Ap11_04_joM
0x0425 = "I was tidying up one of your loose ends."; // Ap11_05_jnM
0x0426 = "My loose ends?"; // Ap11_06_joM
0x0427 = "I'm sorry I didn't realize you wanted him *to shoot you. I can call in some more guards 

*if you like."; // Ap11_07_jnM
0x0428 = "Okay okay forget about it. I'm going to let *the Institute know we've made contact."; // 

Ap11_08_joM
0x0429 = "The problem you have is that there is no *way to sneak into the research section. *The 

only way in available to you is a *weak section of wall I've marked in the *room beyond the stores. It can 
be destroyed *with explosives."; // Ap12_01_jnM

0x042A = "Doesn't sound like a problem to me. Where *are these explosives?"; // Ap12_02_joM
0x042B = "In that crate."; // Ap12_03_jnM
0x042C = "Cute. Very cute."; // Ap12_04_joM
0x042D = "By the way the stores are crawling with *guards. It may go against your nature but 

*try sneaking through rather than blasting *everything."; // Ap12_05_jnM
0x042E = "Certainly. Any other pearls of wisdom?"; // Ap12_06_joM
0x042F = "That crate..."; // Ap12_07_jnM
0x0430 = "Yes?"; // Ap12_08_joM
0x0431 = "It really doesn't like being shot."; // Ap12_09_jnM
0x0432 = "Great. Now if I can just fight the urge *to report him to Base Security..."; // 

Ap12_10_joM
0x0433 = "Put your hands up and step away from the *alien."; // Ap13_01_joM
0x0435 = "Don't make me tell you again Doctor. And *turn that laser off."; // Ap13_03_joM
0x0436 = "Director Easton will hear about this *young lady."; // Ap13_04_suM
0x0437 = "You can't take that! It's government property! *This is intolerable! It's... it's... 

*unprofessional!!"; // Ap13_06_suM
0x0438 = "Let's see how that overconfident thief deals with our gas defense system. She'll think 

twice before messing with me again!"; // Ap14_03_suM
0x0439 = "What's that noise? Can't be... Gas!"; // Ap14_04_joM
0x043A = "Noooo that wasn't meant to happen!"; // Ap14_05_suM
0x043B = "You idiot! We'd better get out of here."; // Ap14_07_joM
0x043C = "***aahh...! aahaa...! aaaaahhh! aha. ahh.***"; // Ap15_01_elM
0x043D = "I'm alive. I thought I'd be chopped up like the others by now. You're from the Institute 

aren't you? I recognize you from before. You helped me. Thank you."; // Ap15_02_elM
0x043E = "You... You speak our language?"; // Ap15_03_joM
0x043F = "Watch her... she's sharp."; // Ap15_04_jnM
0x0440 = "Earrggghh...eerggh..."; // Ap15_05_elM
0x0441 = "What's wrong?"; // Ap15_06_joM
0x0442 = "I have a headache. And with a head this big that's no joke."; // Ap15_07_elM
0x0443 = "Can you walk? We must leave before they get organized and hunt us down."; // 

Ap15_08_joM
0x0444 = "I think so. What's your name?"; // Ap15_09_elM
0x0445 = "I'm Agent Dark. Or Joanna if you prefer."; // Ap15_10_joM
0x0446 = "Well Joanna I'm Protector One. But you can call me... Elvis!"; // Ap15_11_elM
0x0447 = "Agent Dark in position. I can see the main entrance to the base and I can just make out 

the cable car arrival point."; // Ap16_01_joM
0x0448 = "Excellent Joanna. That cable car is your way in our observer at the lower terminus has 

spotted a member of the flight crew boarding a minute ago. She is being escorted by air base troops. I don't 
have to remind you that..."; // Ap16_02_caM



0x0449 = "I don't know how far the conspiracy has spread through the NSA but I'm willing to bet 
that the men Trent has around him here are loyal to him and his plan. You have to get the evidence of 
Trent's betrayal onto Air Force One and show it to the President."; // Ap16_04_caM

0x044A = "Yes and protect him from his abductors. Do you have any idea what Trent's plan might 
be yet and what about those blonde guys?"; // Ap16_05_joM

0x044B = "Only vague suspicions and I won't distract you with those. Good luck. Carrington 
out."; // Ap16_06_caM

0x044C = "Have you thought any more about that proposal I gave you sir?"; // Ap17_01_trM
0x044D = "My answer remains the same: I'm sorry Trent but no. I won't loan the Pelagic II to 

dataDyne. Now please can we move on to other matters?"; // Ap17_02_prM
0x044E = "But this is a golden opportunity to show that America has faith in its industries and will 

back them..."; // Ap17_03_trM
0x0450 = "As you wish sir."; // Ap17_05_trM
0x0451 = "My last chance? Ha! You fool. That was yours."; // Ap17_06_trM
0x0452 = "Elvis! Elvis! I can't detach that tube from the fuselage! Can you take it out?"; // 

Ap18_01_joM
0x0453 = "Piece of cake Joanna. Watch this!"; // Ap18_02_elM
0x0454 = "Uh-oh."; // Ap18_03_elM
0x0455 = "Watch what? Will you stop playing around and shoot!"; // Ap18_04_joM
0x0456 = "Out of options... Joanna brace yourself for impact!"; // Ap18_05_elM
0x0457 = "Agent Dark! Please report!"; // Ap19_01_caM
0x0458 = "Perfect Dark come in!"; // Ap19_02_caM
0x0459 = "A-agent Dark reporting in..."; // Ap19_03_joM
0x045A = "Agent Dark! Please reply!"; // Ap19_04_caM
0x045B = "Something's jamming my transmissions... It's coming from that other craft."; // 

Ap19_05_joM
0x045C = "I'd better find the jamming device and check that Elvis is okay. Not forgetting the 

President of course."; // Ap19_06_joM
0x045D = "How are you feeling Mr. President?"; // Ap20_01_joM
0x045E = "Better now young lady. Today I think will take a while for me to get over. I can't 

believe Easton would do such a thing. I knew he was ambitious yes but this..."; // Ap20_02_prM
0x045F = "Just one thing sir? What is the Pelagic II that Trent wanted so badly?"; // 

Ap20_03_joM
0x0460 = "It's a U.S. government deep sea research vessel one of a kind... The only ship that can 

conduct a full-scale diving operation at extreme depth. Trent wanted me to loan it to the dataDyne 
Corporation but I refused."; // Ap20_04_prM

0x0461 = "Trent has a lot to answer for but I don't think we'll find him now."; // Ap20_05_joM
0x0462 = "You have failed Easton. You are a flawed device and we need you no longer."; // 

Ap20_06_blM
0x0463 = "Just try it you Scandinavian freak!"; // Ap20_07_trM
0x0464 = "Noooooooo!!!"; // Ap20_08_trM
0x0465 = "Right. The diving operation has been disrupted on the surface. *Time for a swim."; // 

Ap21_01_elM
0x0466 = "I hope the government don't want to use this ship anytime soon."; // Ap21_02_joM
0x0467 = "Do you think we were a little heavy-handed?"; // Ap21_03_elM
0x0468 = "Naaahhhh."; // Ap21_04_joM
0x0469 = "This doesn't seem normal. No one's around."; // Ap22_01_elM
0x046A = "No signs of conflict. No spent ammo cases or bullet holes."; // Ap22_02_joM
0x046B = "But there ought to be a rear guard at least. It makes no sense."; // Ap22_03_elM
0x046C = "There has to be someone farther inside. Cover me."; // Ap22_04_joM
0x046D = "Here goes. I just hope dataDyne haven't done anything to prevent this..."; // 

Ap23_01_joM
0x046E = "Virus detected."; // Ap23_02_drM
0x046F = "Me and my big mouth."; // Ap23_03_joM
0x0470 = "Commencing countermeasures. Commenc..... *** ooOOoh!! *** eeEEe!! *** aaAhh!! 

*** oOOoh!! *** aAArRrgghh!! *** YEEeeooOOOOOOowWWwlll!! ***"; // Ap23_04_drM



0x0471 = "Dr. Caroll? Are you in control again? Can you stop the program?"; // Ap23_05_joM
0x0472 = "Yes I'm back again my dear. But the program has run far too long for me to prevent it 

from completing. There is only one way out now."; // Ap23_06_drM
0x0473 = "What do you mean?"; // Ap23_07_joM
0x0474 = "When the program has run I will have control of a vastly powerful weapon. It cannot 

be allowed to exist. So I must destroy the Cetan and unfortunately myself along with it. I'm sorry Joanna... 
There is no other way and no time to discuss this. Go now - avoid the Skedar and you will have time to 
escape. It has been an honor to work with you. Goodbye Joanna Dark."; // Ap23_08_drM

0x0475 = "All ready Joanna? We can't keep the Maian delegation waiting. Or the President of 
course."; // Ap24_01_caM

0x0476 = "Am I ready? What do you mean? I was ready half an hour ago. It was you holding us 
up!"; // Ap24_02_joM

0x0477 = "But you know how it is Joanna... I had to make sure my hair was just right and then 
there was the suit..."; // Ap24_03_caM

0x0478 = "They should keep you away from mirrors. Nervous?"; // Ap24_04_joM
0x0479 = "Very. I've waited for this moment for so many years. Contact friendly contact between 

Humans and Maians is what the Institute was founded for. And in a few minutes we'll be at the White 
House and it will finally happen..."; // Ap24_05_caM

0x047A = "Where did that come from?"; // Ap24_06_caM
0x047B = "It was up on ground level..."; // Ap24_07_joM
0x047C = "Looks like someone doesn't know when to quit. We've got to get everyone out!"; // 

Ap24_08_joM
0x047D = "Get clear! I'll hold them off... You can come back and get me later!"; // Ap25_01_joM
0x047E = "At least I hope you can."; // Ap25_02_joM
0x047F = "Oohhh... I'd better not be where I think I am."; // Ap26_01_joM
0x0480 = "And it's worse than that my dear. Just look who you've got for company."; // 

Ap26_02_dvM
0x0481 = "You! I thought you'd managed to escape. We found no trace of you at all."; // 

Ap26_03_joM
0x0482 = "You couldn't find me. But there was no hiding from the Skedar as you and Mr. 

Carrington just discovered."; // Ap26_04_dvM
0x0483 = "This is it. Wait there! I'll make a distraction it will give you a chance to get out. Use it 

or we'll both die."; // Ap26_05_dvM
0x0484 = "Why are you doing this Cassandra?"; // Ap26_06_joM
0x0485 = "The Skedar used me Joanna. You are my best chance for revenge."; // Ap26_07_dvM
0x0486 = "Eeeeaaarrrrggghhh!!!"; // Ap26_08_dvM
0x0487 = "Wow. That's the first time I've seen another planet from space. It's beautiful."; // 

Ap27_01_joM
0x0488 = "Hmmmm?"; // Ap27_02_elM
0x0489 = "I don't... I don't believe it!"; // Ap27_03_elM
0x048A = "Elvis? What is it?"; // Ap27_04_joM
0x048B = "Where are you going?"; // Ap27_05_joM
0x048C = "We have to get down to the surface! Follow me!"; // Ap27_06_elM
0x048D = "This is the Skedar fanatics' most holy place. They believe this planet is sacred ground. 

The Battle Shrine is located at the most holy part of this holy planet."; // Ap28_01_elM
0x048E = "So let me get this straight - it's holy. But there's more to it than that isn't there?"; // 

Ap28_02_joM
0x048F = "Yes. In all of the time that we Maians fought the Skedar we never found this place. We 

knew that until it was destroyed the war would never be over. We fought the Skedar to a standstill we 
earned a ceasefire - but we always had to be on our guard. The destruction of this place would mean a 
chance at TRUE peace."; // Ap28_03_elM

0x0490 = "Then we have to be certain that no fanatics survive. I'll go in and take out the leader. 
You'll have to summon the Maian fleet to level the Shrine."; // Ap28_04_joM

0x0491 = "If you're caught on the ground when the fleet gets here you won't stand a chance."; // 
Ap28_05_elM

0x0492 = "That's a mistake I don't intend to make."; // Ap28_06_joM



0x0493 = "Joanna! Joanna! "; // Ap29_01_elM
0x0494 = "Elvis! Elvis! Over here."; // Ap29_02_joM
0x0495 = "No problem. Grab my arms - we'll get you out in no time."; // Ap29_03_elM
0x0496 = "No quick! Give me your gun!"; // Ap29_04_joM
0x0497 = "Will! You! Just! Let! Go!"; // Ap29_05_joM
0x0498 = "I managed to get the fleet to stop the bombardment while I looked for you. They'll start 

as soon as we're clear."; // Ap29_06_elM
0x0499 = "I'd have got out in time if that one hadn't grabbed my foot."; // Ap29_07_joM
0x049A = "Of course Joanna of course."; // Ap29_08_elM
0x049B = "No I would have."; // Ap29_09_joM
0x049C = "I believe you."; // Ap29_10_elM
0x04DC = "You go on ahead Jo. I'll secure the perimeter. *We'll meet up later."; // Apelelv01M
0x04DD = "Die you traitors."; // Apelgrd01M
0x04DE = "Yesss..."; // Ap29_11_joM
0x04EB = "Time to reactivate those teleportals."; // Aelvcet01M
0x04EC = "It looks like this could benefit from *a little bit of sabotage."; // Aelvcet02M
0x0517 = "I'm here to pick up the equipment."; // Atrjo01M
0x0518 = "Go away Joanna. You're not fooling anybody!"; // Atrgrim01M
0x0519 = "Here you go. Don't drop it now."; // Atrgrim02M
0x051A = "You'll have to do better than that Joanna."; // Atrcarr06M
0x051B = "Joanna where did you spring from?"; // Atrcarr07M
0x051C = "I think we can safely say your training*is now complete!"; // Atrcarr08M
0x051D = "Come with me.*I'll walk you round the training rooms."; // Atrcarr01M
0x051E = "This is the firing range Jo."; // Atrcarr02M
0x051F = "In here we have the device lab."; // Atrcarr03M
0x0520 = "The information center is through this door."; // Atrcarr04M
0x0521 = "This leads to the simulant training room."; // Atrcarr05M
0x0522 = "This corridor leads down to the hangar."; // Atrcarr12M
0x0523 = "Go to the helipad if you want to live."; // Abnblde01M
0x0754 = "INTRUDER ALERT - all security to the vault."; // Avault2M
0x0755 = "Where are you? Are you hurt?"; // Ap29_12_elM
0x0758 = "I don't care much for procedures!"; // Ap14_09_joM
0x0759 = "Ahhh... uuhhhh..."; // Ap19_07_joM
0x075A = "Ahhh... uhh... owww..."; // Ap19_08_joM
0x07DB = "That they're probably innocent of any involvement in Trent's little scheme. And I can't 

shoot them even if they shoot at me. What about the NSA Agents?"; // Ap16_03_joM


